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Статья адресована читателям нашей книги "Fruity Loops Studio: музыкальная 
фабрика на PC". В этой книге подробно рассматривается программа FL Studio 
версии 4.5.2. Практически одновременно с выходом книги вышла новая версия FL 
Studio 5, а затем, спустя пару недель, ее обновление до 5.0.1. 

Программный продукт FL Studio находится в состоянии перманентной доработки и 
совершенствования. Складывается впечатление, что присвоение номеров версиям 
FL Studio происходит по следующему принципу: над программой ведется 
непрерывная работа, а выходы новых версий приурочиваются к каким-либо датам 
вне зависимости от объема нововведений в программе. В пользу этого 
предположения свидетельствует тот факт, что версия 4.5.2 отличается от 4.0 
гораздо сильнее, чем 5.0 от 4.5.2, а версия 5 вышла как раз к новогодним 
праздникам 2005 года. 

Изменений в FL Studio 5.0 действительно немного. Тем не менее, новая версия FL 
Studio вышла, и мы решили написать статью, чтобы поддержать наших читателей. В 
ней мы подробно расмотрели все изменения и нововведения. Кроме того, в 
дополнение к книге "Fruity Loops Studio: музыкальная фабрика на PC" мы привели 
более подробные описания некоторых меню.  

1. Настройки FL Studio
2. Панели инструментов
3. Окно Mixer (микшер)
4. Подробное описание окна Remote control settings
5. Окно Piano roll
5.1. Новые команды подменю Tools меню окна Piano roll
5.2. Новая команда подменю View меню окна Piano roll
6. Окно Play list, автоматизация
6.1. Автоматизация аудиоклипов
6.2. Автоматизация любых параметров синтеза с помощью клипов автоматизации
6.3. Некоторые команды меню окна Playlist
7. Генераторы
7.1. Встроенный сэмплер
7.2. Плеер барабанных лупов Fruity Slicer
7.3. Драм-машина FPC (полное описание)
  7.3.1. Вкладка PADS панели FPC - параметры пэдов
  7.3.2. Вкладка LAYER PROPERTIES панели FPC - параметры слоев
  7.3.3. Вкладка MIXER панели FPC - встроенный микшер
  7.3.4. Работа с шаблонами партий ударных инструментов
  7.3.5. Создание собственных пресетов с наборами ударных звуков
7.4. Гранулярный синтезатор Fruity Granulizer
7.5. Fruity Video Player - проигрыватель видеофайлов
7.6. Плагин WaveShaper (полное описание)
8. Новые команды главного меню
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1. Настройки FL Studio 

Подраздел MIDI раздела System окна Settings (открывается командой OPTIONS > 
MIDI Settings главного меню или нажатием клавиши <F10>): в списке Controller type 
(тип контроллера) добавилась возможность выбора следующих устройств 
управления: Hercules DJ Console, Korg MS-20 Controller, Korg microKONTROL (рис. 1). 

 
Рис. 1. Подраздел MIDI раздела System окна Settings

В группе Keyboard input вместо опции Ignore velocities появился список Link 
velocity to: - как поступать с информацией о скорости нажатия MIDI-клавиш: (none) - 
игнорировать; Velocity - пропускать без обработки; Filt. cut - преобразовывать в 
информацию, управляющую частотой среза фильтров; Filt. res - преобразовывать в 
информацию, управляющую добротностью фильтров. 
В подразделе AUDIO раздела System окна Settings (открывается командой 
OPTIONS > Audio Settings главного меню), в группе Mixer появился список 
Interpolation (рис. 2). 

 
Рис. 2. Подраздел AUDIO раздела System диалогового окна Settings



В данном списке можно выбирать алгоритм интерполяции (сглаживания волновой 
формы), который будет применяться во встроенных сэмплерах FL Studio при 
воспроизведении проекта. Самый быстрый алгоритм Linear соответствует наиболее 
низкому качеству звучания и наиболее низкой нагрузке на процессор (CPU). Самый 
медленный алгоритм Sinc depth 256 обеспечивает наилучшее качество звучания, но 
создает большую нагрузку на CPU. В предыдущих версиях FL Studio алгоритм 
интерполяции можно было задавать только при экспорте проекта. При 
воспроизведении проекта в режиме реального времени в целях экономии 
вычислительных ресурсов использовался не самый качественный алгоритм 
интерполяции 

В подразделе INFO (информация о проекте) раздела Project окна Settings 
появилась дополнительные поля: Genre - жанр; Author - автор (рис. 3). 

 
Рис. 3. Подраздел INFO раздела Project диалогового окна Settings

 

2. Панели инструментов 

В FL Studio 5 недоступна панель для выбора текущего паттерна. Поле PAT (номер 
текущего паттерна) вынесено на транспортную панель (рис. 4). 

 
Рис. 4. Транспортная панель 

В контекстном меню поля TEMPO, открываемого щелчком на целой части числа, 
задающего темп, появилась команда Tap - вычислить темп по щелчкам 
пользователя. После вызова команды открывается окно с изображением 
водопроводного крана. Щелкайте на нем, а программа будет вычислять и 
отображать темп ваших щелчков. 



На панели Recording (рис. 5) появились дополнительные опции. 

 
Рис. 5. Панель Recording

, Options > Loop record - включение/выключение режима циклической записи. В 
нем запись данных с MIDI-клавиатуры (или заменяющей ее клавиатуры PC) 
производится в цикле. Каждый раз указатель текущей позиции, дойдя до конца 
паттерна, "перепрыгнет" в его начало и так продолжится до тех пор, пока запись не 
будет остановлена. При этом вновь записанный материал заменит собой материал, 
записанный ранее. 

, Options > Auto scrolling - включение/выключение режима автоматического 
скроллинга в окнах пошагового секвенсора, Piano roll и Playlist. При включенном 
режиме автоматического скроллинга воспроизводимая в данный момент позиция 
паттерна, трека отпечатков клавиш или проекта всегда будет находиться в зоне 
видимости. 

Приведем более подробное описание режимов привязки (SNAP): 

• Line - привязка к вертикальным вспомогательным линиям, шаг которых может 
отличаться для разных масштабов отображения;  

• Cell - способ привязки, аналогичный предыдущему при рисовании отпечатков;  
• 1/4 step - 1/4 шага пошагового секвенсора;  
• 1/2 step - 1/2 шага пошагового секвенсора;  
• Step - 1 шаг пошагового секвенсора;  
• 1/6 beat - 1/6 доли;  
• 1/4 beat - 1/4 доли;  
• 1/3 beat - 1/3 доли;  
• 1/2 beat - 1/2 доли;  
• Beat - доля;  
• Bar - такт.  

Различия между способами привязки клавиш к сетке Line и Cell проявляются только 
при применении квантизации. Если выбран режим привязки Line, привязка границ 
каждого выделенного отпечатка осуществляется к ближайшим вертикальным 
линиям. Если выбран режим привязки Cell, то привязка границ отпечатка 
осуществляется к ближайшим вертикальным линиям, расположенным слева. 

3. Окно Mixer (микшер) 

Описание команд меню слота для подключения плагинов (меню открывается с 
помощью кнопки ): 

• Select - меню для выбора подключаемого плагина;  
• Browse presets - открыть в браузере Browser папку с пресетами для данного 

плагина;  
• Save preset as - сохранить настройки плагина в файл пресета;  
• Last tweaked parameter - набор команд, относящихся к тому параметру 

плагина, значение которого было изменено в последнюю очередь (см. 
описание команд контекстного меню регуляторов в разд. 2.8.4 книги).  
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• Browse parameters - открыть в браузере Browser папку с параметрами 
данного плагина;  

• View editor - открыть окно плагина;  
• Set name - переименовать название подключенного экземпляра плагина;  
• Smart disable - режим экономии ресурсов процессора при отсутствии 

звукового сигнала на входе плагина;  
• Move up - переместить плагин в слот, расположенный выше;  
• Move down - переместить плагин в слот, расположенный ниже;  
• Help - вызов справки по данному плагину.  

Несколько слов о режиме Smart disable. Если данный режим включен, то программа 
анализирует - поступает ли на вход плагина звуковой сигнал. Если на вход плагина в 
течение четырех секунд кроме тишины ничего не поступает, то незаметно для 
пользователя он отключается. Это позволяет экономить ресурсы процессора. Как 
только на вход плагина вновь начинает поступать звуковой сигнал, плагин мгновенно 
включается. При включении/выключении плагина не возникает никаких побочных 
звуков (например, щелчков). Однако данный режим можно использовать не для всех 
типов эффектов. Например, его не рекомендуется применять для длительной 
реверберации: по истечении четырех секунд после затухания сигнала на входе 
плагина он отключится, однако в момент отключения сигнал на выходе плагина 
может еще присутствовать. 

Описание команд меню микшера, открываемого с помощью кнопки (Effects 
options): 

• File > Open mixer track state - загрузить настройки текущего модуля микшера 
из файла;  

• File > Save mixer track state as - сохранить настройки текущего модуля 
микшера в файле;  

• View > Controls, <Alt> + <C> - отобразить/скрыть фейдеры громкости и 
регуляторы панорамы для всех модулей микшера;  

• View > Names, <Alt> + <C> - отобразить/скрыть названия модулей микшера;  
• Disk recording > Render to wave file(s)…, <Alt> + <R > - экспорт звуковых 

данных с модулей микшера, подготовленных к записи в один или несколько 
звуковых файлов;  

• Disk recording > Auto-unarm - автоматически выключать режим готовности к 
записи после ее завершения;  

• Disk recording > Auto-create audio clip - автоматически создавать 
аудиоклипы в окне Playlist используя вновь записанные звуковые файлы;  

• Disk recording > Latency compensation - компенсация задержки 
записываемого сигнала;  

• Disk recording > 32Bit float recording - запись звуковых файлов в 32-битном 
формате с плавающей точкой (если опция выключена, то запись будет 
производиться в 16-битном формате);  

• Link selected channels > To this track, <Ctrl> + <L> - выделенные в окне 
пошагового секвенсора каналы будут связаны с текущим модулем микшера;  

• Link selected channels > Starting from this track - выделенные в окне 
пошагового секвенсора каналы будут связаны с текущим и последующими 
модулями микшера (каждый канал с отдельным модулем микшера);  

• Selected linked channels, <Alt> + <L> - выделить в окне пошагового 
секвенсора все каналы, связанные с текущим модулем микшера;  

• Rename - переименовать текущий модуль микшера;  



• Switch smart disable for all - включение/выключение режима Smart disable 
(экономия вычислительных ресурсов при "простое" плагина) сразу для всех 
задействованных плагинов.  

Несколько слов о функции компенсации задержки. Задержка возникает при 
прохождении потока звуковых данных сквозь драйвер звуковой карты. При 
использовании ASIO-драйверов, в зависимости от настроек аудиоинтерфейса эта 
задержка может быть очень маленькой. Тем не менее, ее следует компенсировать. 
Компенсация заключается в том, что создаваемые в окне Playlist аудиоклипы будут 
размещаться с учетом этой задержки. В некоторых случаях по "вине" драйверов 
звуковой карты функция компенсации задержки может работать не вполне 
корректно. Вам придется самостоятельно передвигать аудиоклипы так, чтобы 
записанный в них аудиоматериал соответствовал остальному материалу проекта. 

Если вы используете драйверы ASIO, то после выбора входного порта в поле IN 
автоматически включится режим готовности записи файла с именем, принятым по 
умолчанию. Об этом будет свидетельствовать тот факт, что символ , 
расположенный в правом нижнем углу микшера, будет выделен ярким цветом. 

Щелчком правой кнопки мыши на поле OUT открывается контекстное меню, 
содержащее следующие команды: 

• Reset mapping - установить принятые по умолчанию настройки выходных 
портов всех модулей микшера;  

• Auto map outputs - автоматически распределить модули микшера по 
доступным выходным портам.  

При записи звуковых сигналов от внешних источников средствами FL Studio 
необходимо задавать имена соответствующих звуковых файлов. Щелчком на 
надписи REC, расположенной в правом нижнем углу окна Mixer, вызывается 
стандартное диалоговое окно для присвоения имени звуковому файлу. FL Studio 5 
может присваивать имена записываемым звуковым файлам автоматически. Для 
этого нужно щелкнуть на надписи REC правой кнопкой мыши. Чтобы узнать имя 
файла, куда будет осуществляться запись, подведите указатель мыши к полю REC и 
прочитайте имя в информационной строке главной панели. 

Если во время записи звукового файла что-то пошло не так, то в FL Studio 5 сессию 
записи можно отменить командой главного меню EDIT > Undo. 

Следует иметь в виду, что все записанные с помощью FL Studio звуковые файлы 
доступны в папке RECORDED браузера Browser. Оттуда их можно перетаскивать в 
секцию аудиотреков окна Playlist или же в окно пошагового секвенсора. 

Если щелкнуть на нужном звуковом файле в браузере правой кнопкой мыши, 
откроется контекстное меню, содержащее несколько полезных команд: 

• Send to selected channel - загрузить сэмпл в генератор, подключенный к 
текущему каналы (команда будет выполнена в том случае, если генератор 
поддерживает загрузку сэмплов);  

• Open in new channel - создать новый канал, задействовав в качестве 
генератора встроенный сэмплер, и загрузить в него выбранный файл;  



• Open in new slicer channel - создать новый канал, задействовав в качестве 
генератора плеер барабанных лупов Fruity Slicer, и загрузить в него 
выбранный файл;  

• Open in new granulizer channel - создать новый канал, задействовав в 
качестве генератора гранулярный синтезатор Fruity Granulizer, и загрузить в 
него выбранный файл.  

В FL Studio имеется возможность экспортировать звуковые данные с выходов 
отдельных модулей микшера. Перед командой экспорта программе необходимо 
указать те модули микшера, данные с которых следует экспортировать. Для этого 
для нужных модулей микшера следует включить режим готовности к записи. Затем 
нажатием кнопки (Effects options), расположенной в левом верхнем углу окна 
Mixer, следует открыть меню и выбрать в нем команду Disk recording > Render to 
wave file(s)… или нажать комбинацию клавиш <Alt> + <R>. Откроется диалоговое 
окно Rendering N mixer tracks (рис. 6). Здесь N - количество модулей микшера, 
звуковые данные которых будут экспортироваться.  

 

Рис. 6. Диалоговое окно Rendering

Как видите, данное окно является "урезанным" вариантом уже знакомого вам окна, 
показанного на рис. 9.3 книги: экспорт можно осуществлять только в файлы формата 
WAV. После нажатия кнопки Start экспорт звуковых данных будет выполнен в 
заданные файлы. 

4. Подробное описание окна Remote control settings 

В этом разделе мы приведем более подробное (в сравнении с имеющимся на стр. 83 
книги) описание окна Remote control settings. 
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Откройте контекстное меню щелчком правой кнопкой мыши на нужном регуляторе, 
выберите команду Link to controller. Откроется окно Remote control settings - 
параметры удаленного управления (рис. 7). 

 

Рис. 7. Окно Remote control settings 

По умолчанию включена опция Auto detect. Это значит, что вам достаточно 
"шевельнуть" нужный контроллер (какое-нибудь колесо или регулятор на MIDI-
клавиатуре), после чего окно закроется, и вы обнаружите, что можете управлять 
выбранным виртуальным регулятором с помощью вполне реальной рукоятки. При 
выполнении записи автоматизации не имеет значения то, как вы управляете 
автоматизируемым параметром, - с помощью мыши или регулятора на MIDI-
клавиатуре. 

Рассмотрим остальные элементы окна Remote control settings. В полях Channel и 
Controller задаются номера MIDI-канала и MIDI-контроллера, используемых для 
удаленного управления. Назначение опции Omni проще проиллюстрировать на 
примере. Допустим, вы хотите управлять с помощью MIDI-контроллера фейдерами 
громкости микшера. Если опция Omni включена, то с помощью заданного MIDI-
контроллера можно управлять фейдером громкости текущего модуля микшера. Т. е. 
одним и тем же MIDI-контроллером можно управлять однотипными регуляторами 
разных модулей микшера. Если опция Omni выключена, то вне зависимости от того, 
какой из модулей выбран в качестве текущего, управлять с помощью MIDI-
контроллера можно только одним определенным фейдером. 

Если включена опция Remove conflicts, то будут автоматически исключаться такие 
логические конфликты, когда один и тот же MIDI-контроллер настроен на управление 
разными параметрами. 

Щелчком на маленьком треугольнике, расположенном левее надписи Mapping 
formula, открывается меню. В данном меню можно выбрать формулу зависимости 
значения параметра, которым управляют дистанционно, от значения управляющего 
MIDI-контроллера. В правой части группы Mapping formula отображается график, 
соответствующий выбранной формуле. 



Опция Smoothing позволяет сгладить "шероховатости" управляющего сигнала, 
сделав инерционным регулятор, которым управляют дистанционно. Эта 
инерционность задается регулятором Time. 

Кнопкой Reset можно "сбросить" настройки дистанционного управления. Кнопка 
Accept (принять настройки дистанционного управления) является аналогом 
стандартной кнопки OK.  

5. Окно Piano roll 

Много новых инструментов для обработки музыкальной информации появилось в 
окне Piano roll. 

5.1. Новые команды подменю Tools меню окна Piano roll

Tools > Quick legato, <Ctrl> + <L> - легато. Ноты звучат слитно, одна за другой, 
причем одновременно может звучать только одна нота. На рис. 8, а показана 
последовательность отпечатков клавиш до применения функции легато. На рис. 8, б 
- после ее применения. 

  а 

  б 

Рис. 8. Применение команды Tools > Quick legato



Tools > Articulate, <Alt> + <L> - артикуляция. Данная функция позволяет 
реализовать приемы исполнения портаменто (скользящего перехода одного звука в 
другой), стаккато (отрывистой игры), легато (слитной игры). 

Команда Tools > Articulate открывает диалоговое окно Piano roll - articulate (рис. 9). 

Если опция Use lengths включена, то обработке будут подвергаться исходные 
длины отпечатков клавиш. Если данная опция выключена, то перед применением 
функции артикуляции фактически будет применена функция легато. 

Регулятором Multiply задается коэффициент, на который умножаются длины 
отпечатков клавиш. Регулятором Variation задается диапазон случайного разброса 
длин отпечатков клавиш. 

 

Рис. 9. Диалоговое окно Piano roll - articulate

На рис. 10, а показана последовательность отпечатков клавиш до применения 
функции артикуляции. На рис. 10, б - после ее применения с включенной опцией Use 
lengths и параметром Multiply, равным 50%. 

  а 



  б 

Рис. 10. Применение команды Tools > Articulate

Tools > Arpeggiate, <Alt> + <A> - функция арпеджио. На рис. 11, а показан аккорд до 
применения функции арпеджио. На рис. 11, б - после ее применения. Из рисунков 
видно, что суть данной функции состоит в поочередном взятии нескольких нот, 
определенным образом связанных с исходной нотой. Так играют на арфе. Термин 
"арпеджио" и означает - "подобно арфе". 

Команда Tools > Arpeggiate открывает диалоговое окно Piano roll - arpeggiator 
(рис. 12). В группе Pattern этого окна расположена всего одна кнопка, открывающая 
стандартное диалоговое окно загрузки файла шаблона. Шаблон используется для 
реализации арпеджио. Данные из шаблона циклически повторяются и 
преобразуются в соответствии с исходными отпечатками клавиш и опциями 
функции. После применения функции преобразованные и многократно повторенные 
данные шаблона заменят собою исходные отпечатки клавиш. В группе Options 
доступны следующие опции: 

• Pattern - способ применения шаблона: Normal - без обработки данных 
шаблона; Flip - изменить порядок следования нот в шаблоне по вертикали; 
Alternete - чередование порядка следования нот (Normal/Flip) при каждом 
циклическом повторе данных шаблона;  

• Time mul - изменение темпа шаблона в целое число раз;  
• Range - диапазон арпеджио, задаваемый в октавах;  
• Sync - условие, при котором очередной циклический повтор шаблона будет 

прерван и воспроизведение шаблона пойдет от его начала: Time - ни при 
каких условиях; Block - при условии достижения конца всех отпечатков 
клавиш в аккорде; Chord - при условии достижения конца любого из 
отпечатков клавиш аккорда;  

• Gate - длительность нот арпеджио;  
• Levels - степень влияния параметров синтеза из шаблона на аналогичные 

параметры оригинальных отпечатков клавиш: PAN - панорама, VOL - 
параметр Velocity (скорость нажатия MIDI-клавиш), CUT и RES - частота среза 
и добротность фильтра, PITCH - смещение высоты тона.  

Если параметр Range выбран равным более чем одной октаве, то становится 
доступным список, расположенный правее поля Range. В этом списке задается 



направление арпеджио: Normal - восходящее арпеджио; Flip - нисходящее 
арпеджио; Alternate - восходяще-нисходящее арпеджио. 

  а 

  б 

Рис. 11. Применение команды Tools > Arpeggiate

 

Рис. 12. Диалоговое окно Piano roll - arpeggiator



Tools > Flam, <Alt> + <F> - функция, имитирующая игру с фиоритурой на ударных 
инструментах (сдвоенные удары). На рис. 13, а показан аккорд до применения 
функции, а на рис. 13, б - после применения функции. Команда Tools > Flam 
открывает диалоговое окно Piano roll - flamer (рис. 14). В результате применения 
функции для каждого исходного отпечатка клавиши создается его смещенный во 
времени дубль. 

  а 

  б 

Рис. 13. Применение команды Tools > Flam

 

Рис. 14. Диалоговое окно Piano roll - flamer



Регулятором Time задается смещение дублей относительно исходных отпечатков 
клавиш. Если опция Absolute включена, то параметр Time задается в абсолютном 
значении времени (в миллисекундах). В противном случае (если опция Absolute 
выключена) параметр Time задается в музыкальном времени (при этом абсолютная 
величина смещения будет зависеть от текущего темпа). 

Before - размещать дубли перед оригинальными отпечатками клавиш. Регулятором 
Velocity задается степень уменьшения параметров Velocity у дублирующих 
отпечатков клавиш. 

После применения функции Tools > Flam имеет смысл воспользоваться командой 
Tools > Quick legato, чтобы отпечатки клавиш не пересекались. 

5.2. Новая команда подменю View меню окна Piano roll

Detached - сделать окно Piano roll независимым от главного окна FL Studio. Если 
данная опция включена, то на компьютере с двумя мониторами главное окно FL 
Studio можно разместить на одном мониторе, а окно Piano roll на втором.  

6. Окно Playlist, клипы автоматизации 
Для автоматизации параметров FL Studio 5 и задействованных в проекте плагинов 
можно использовать клипы автоматизации (automation clips). Клипы автоматизации 
могут размещаться в окне Playlist. Они содержат огибающие автоматизации - 
графики изменения параметров во времени. 
В окне Play list, на поле, расположенном в левой части секции клипов, имеются две 
кнопки: 

(Focus: audio clips) - режим редактирования аудиоклипов; 
(Focus: automation clips) - режим редактирования клипов автоматизации. 

Клипы автоматизации по своему назначению должны располагаться на одних треках 
с аудиоклипами и пересекаться с ними во времени. В режиме редактирования 
аудиоклипов именно аудиоклипы как бы выходят на первый план, с ними удобно 
работать. В режиме редактирования аудиоклипов под кнопкой (Focus: audio 
clips) доступна опция ZERO-CROSS (см. рис. 15). Если данная опция включена, то 
при разрезании клипов точки разреза будут совмещаться с теми местами, где 
волновая форма пересекает линию нулевого уровня. Такая мера позволяет снизить 
вероятность появления щелчков в местах разреза. 

 

Рис. 15. Секция аудиотреков окна Playlist



Новые команды меню аудиоклипа: 

• Make unique - сделать данный аудиоклип уникальным, т. е. создать копию 
соответствующего канала и связать с этим каналом только данный аудиоклип. 
При необходимости программа предложит сохранить сэмпл клипа в 
отдельный звуковой файл.  

• Edit sample - вызвать встроенный или внешний звуковой редактор для 
редактирования звукового материала.  

• Detect tempo - запустить мастер определения темпа звукового материала 
аудиоклипа.  

• Fit to tempo - привязать длительность аудиоклипа к темпу проекта.  
• Automate - подменю, содержащее команды, относящиеся к автоматизации 

аудиотреков.  

Несколько слов о мастере определения темпа, вызываемом командой Detect tempo 
меню аудиоклипа. Целью его работы является определение темпа звукового 
материала, хранимого в аудиоклипе. Если точно известен темп аудиоклипа, то 
средствами FL Studio этот аудиоклип можно модифицировать так, чтобы его темп 
соответствовал темпу проекта. Например, для этого можно использовать команду Fit 
to tempo меню аудиоклипа. Для успешной работы мастера определения темпа 
необходимо, чтобы звуковой материал клипа имел ярко выраженный ритм. Такой 
характер, в частности, могут иметь барабанные лупы. Сразу после запуска командой 
Detect tempo (меню аудиоклипа) мастер попытается получить информацию о темпе 
из самого звукового файла: в звуковом файле может присутствовать служебная 
информация, включая темп и количество долей. Если этой информации в звуковом 
файле нет, то мастер попытается определить темп с вашей помощью. Откроется 
диалоговое окно. Посредством него вам будет предложено выбрать диапазон, в 
котором, по вашему мнению, находится темп аудиоклипа. После определения темпа 
мастер предложит установить этот темп для проекта. 

Если хотя бы для одного из аудиоклипов проекта включена опция привязки его 
длительности к темпу Fit to tempo, то при изменении темпа проекта будет выдан 
запрос: осуществлять ли растяжение/сжатие аудиоклипов с учетом нового темпа? 

6.1. Автоматизация аудиоклипов

С помощью клипов автоматизации можно управлять лишь двумя параметрами 
аудиоклипов: громкостью и панорамой. Самый простой способ создания клипа 
автоматизации: с помощью команд меню клипа Automate > Panning - создать клип 
автоматизации панорамы и Automate > Volume - создать клип автоматизации 
громкости. Вновь созданный клип автоматизации будет расположен на том же месте, 
что и аудиоклип. В названии клипа автоматизации будет фигурировать название 
аудиоклипа. 

На первый взгляд может показаться, что огибающая автоматизации влияет на 
громкость или панораму того аудиоклипа, над котором расположен клип 
автоматизации. Однако это не так. Когда вы создаете клип автоматизации с 
помощью команды меню аудиоклипа, вновь созданный клип автоматизации будет 
управлять панорамой или громкостью именно этого аудиоклипа. При этом не важно, 
где располагается клип автоматизации. Вы можете перемещать клип автоматизации 
как угодно, располагать его над другими аудиоклипами, однако управлять он будет 
параметром исходного аудиоклипа. 



Когда указатель мыши находится над клипом автоматизации, становятся 
доступными элементы управления огибающей автоматизации, являющейся 
принадлежностью данного клипа. 

Огибающая автоматизации - это график изменения параметра (громкости или 
панорамы) во времени. Высота линии в текущей позиции проекта соответствует 
значению автоматизированного параметра. Узловые точки огибающих обозначаются 
маленькими квадратиками. Их можно перемещать в любом направлении (рис. 16, а). 
Чтобы добавить новый узел, следует щелкнуть правой кнопкой мыши на нужном 
месте огибающей. Между узловыми точками располагается элемент управления в 
виде маленького кружка. Перемещая этот кружок вверх/вниз, можно изменять 
кривизну огибающей на данном отрезке (рис. 16, б). Чтобы вернуть этот кружок в 
нейтральное положение, следует щелкнуть на нем правой кнопкой мыши. 

  а 

  б 

Рис. 16. Редактирование огибающей автоматизации 

У каждого узла огибающей имеется контекстное меню, вызываемое щелчком правой 
кнопки мыши на узле. С помощью команды Delete данного меню узловая точка 
удаляется. С помощью остальных команд контекстного меню можно изменять 
характер изгиба огибающей на отрезке перед данным узлом автоматизации: 

• Single curve - рис. 17, а, б.  
• Double curve - рис. 17, в, г.  
• Hold - рис. 17, д.  
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Рис. 17. Варианты изгибов огибающей автоматизации между двумя узловыми точками 

В режиме редактирования клипов автоматизации, когда нажата кнопка 
(Focus: automation clips), расположенная в левой части секции аудиоклипов, под 
этой кнопкой доступны опции STEP и SLIDE. Данные опции включают/выключают 
соответствующие режимы редактирования огибающих автоматизации. В режиме 
STEP, удерживая нажатой левую кнопку мыши, можно рисовать последовательности 
узловых точек. Если вы станете перемещать какой-либо узел при включенном 
режиме SLIDE, то расположенные справа от него узлы тоже будут перемещаться. 
Если режим SLIDE выключен, то перемещать узловую точку можно только в 
пределах отрезка, ограниченного соседними узлами. 

В окне пошагового секвенсора клипу автоматизации соответствует канал, к которому 
в качестве генератора подключен специализированный плагин Automation clip. 
Каналы, ответственные за автоматизацию, по умолчанию объединяются в группу 
Automation clips. 

На рис. 18 показан вид окна Channel settings для плагина Automation clip. Окно 
Channel settings для конкретного клипа автоматизации можно вызвать одноименной 
командой меню данного кипа. Меню клипов автоматизации вызывается точно так же, 
как и меню аудиоклипов - щелчком на маленьком треугольнике, расположенном в 
левой верхней части клипа. 



 

Рис. 18. Окно Channel settings (плагин Automation clip) 

Плагин Automation clip содержит генератор сигналов низкой частоты LFO, который 
может использоваться для модуляции автоматизируемого параметра. Если 
включена опция Multiply, то генерируемый LFO сигнал будет умножаться на сигнал, 
который соответствует огибающей автоматизации. Если опция выключена, то для 
модуляции автоматизируемого параметра будет использоваться только LFO, а 
огибающая автоматизации будет игнорироваться. Доступны следующие параметры 
генератора LFO: 

• SPD - частота генерируемого сигнала;  
• TENS и SK - форма и наклон периодического сигнала;  
• PW - скважность сигнала;  
• LVL - амплитуда сигнала.  
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Рис. 19. Вид клипа автоматизации с разными настройками генератора LFO 

Назначение перечисленных параметров не сложно понять, если "поиграть" этими 
параметрами на практике. Сделайте так, чтобы одновременно был виден клип 
автоматизации в окне Playlist и параметры соответствующего ему плагина 
Automation clip в окне Channel settings. Изменяйте параметры группы LFO и 
смотрите, что происходит с клипом автоматизации. На рис. 19, а, б 
проиллюстрировано следующее. Толстая светлая линия - это огибающая 
автоматизации. Более тонкая линия сложной формы - это сигнал генератора LFO, 
умноженный на огибающую автоматизации. Именно этим сложным сигналом будет 
модулироваться автоматизируемый параметр. На рис. 19, а, б показано два 
варианта сигнала, соответствующие разным настройкам параметра TENS 
генератора LFO. В действительности существует огромное количество разных 
вариантов формы сигнала LFO. 

6.2. Автоматизация любых параметров синтеза с помощью клипов 
автоматизации

С помощью огибающих автоматизации можно управлять любыми параметрами FL 
Studio, а также подключенных к проекту плагинов формата Fruity. Делается это 
очень просто: щелкаете на нужном регуляторе какого-либо параметра правой 
кнопкой мыши, открывается контекстное меню. В нем выбираете команду Create 
automation clip. Создается новый канал с генератором Automation clip. Открываете 
окно Playlist и создаете в секции аудиотреков клип автоматизации, щелкнув на 
нужном месте инструментом (Draw) или (Paint). Созданный клип автоматизации 
будет управлять нужным вам параметром. 

6.3. Некоторые команды меню окна Playlist

Patterns > Open in project browser, <Alt> + <P> - отобразить в окне браузера 
Browser папку, соответствующую текущему паттерну. Эта папка будет 
присутствовать только в том случае, если паттерн содержит треки с данными 
автоматизации (не путать с клипами автоматизации). 

Detached - сделать окно Playlist независимым от главного окна FL Studio. Если 
данная опция включена, то на компьютере с двумя мониторами главное окно FL 
Studio можно разместить на одном мониторе, а окно Playlist на втором. 

 

 

 



7. Генераторы 

В составе FL Studio 5 появились новые плагины генераторов. Кроме того, был 
доработан встроенный сэмплер и некоторые плагины. 

7.1. Встроенный сэмплер

В окне встроенного сэмплера (рис. 20) появились новые опции Load regions и Load 
ACID markers. Звуковые файлы могут содержать информацию о разбивке сэмпла на 
отдельные фрагменты. Если включена опция Load regions, то эта информация 
будет использоваться FL Studio. Если включена опция Load ACID markers, то 
информация о разбивке сэмпла будет извлекаться из звуковых файлов формата 
редактора Sound Foundry ACID (http://mediasoftware.sonypictures.com). 

 

Рис. 20. Вкладка SMP окна Channel settings

Появилась новая группа Time stretching. Данная группа содержит параметры 
работы одноименного алгоритма обработки звуковых данных, позволяющего 
изменять длительность звучания сэмплов без изменения высоты тона или наоборот, 
изменять высоту тона без изменения длительности. 

Регулятором PITCH можно изменять высоту тона сэмпла без изменения его 
длительности. 

Регулятором MUL задается длительность звучания сэмпла в процентном отношении 
от исходной длительности его звучания. 

http://mediasoftware.sonypictures.com/


Регулятором TIME можно задавать длительность звучания сэмпла в формате 
музыкального времени. Эта длительность будет сохраняться вне зависимости от 
темпа проекта. Если регулятор TIME находится в крайнем левом положении, 
абсолютная длительность сэмпла изменяться не будет. Контекстное меню 
регулятора TIME содержит набор команд, которые в большинстве случаев 
позволяют упростить процедуру "подгона" длительности сэмпла под текущий темп 
проекта: 

• (none) - не изменять длительность сэмпла;  
• Autodetect - автоматическое определение музыкальной длительности сэмпла;  
• 1 beat, 2 beat - принять музыкальную длительность сэмпла равной 1 и 2 

долям соответственно;  
• 1 bar, 2 bars, 3 bars, 4 bars - принять музыкальную длительность сэмпла 

равной 1, 2, 3, 4 тактам соответственно.  

Так или иначе, музыкальная длительность сэмпла, заданная регулятором TIME, 
будет выдерживаться вне зависимости от текущего темпа проекта. А что будет 
происходить с высотой тона при изменении темпа? Это зависит от того, какой 
алгоритм обработки сэмпла выбран в поле, расположенном правее регулятора 
TIME: 

• Resample - ресэмплирование, т. е. изменение скорости воспроизведения 
исходного сэмпла: высота тона будет изменяться в зависимости от текущего 
темпа (алгоритм работает в масштабе реального времени);  

• Elastique (drums) - специальный алгоритм изменения длительности без 
изменения высоты тона, оптимизированный для партий ударных 
инструментов;  

• Elastique (tonal) - специальный алгоритм изменения длительности без 
изменения высоты тона, оптимизированный для партий мелодических 
инструментов;  

• Elastique (slices) - алгоритм, при котором исходный сэмпл автоматически 
разбивается на отдельные фрагменты, и дальнейшая их обработка 
происходит подобно тому, как это осуществляется в специальном плеере 
барабанных лупов Fruity Slicer;  

• Slice map - еще одна модификация алгоритма Elastique (slices), в которой не 
обрабатываются места "швов" между фрагментами сэмпла;  

• Auto - автоматический выбор наилучшего алгоритма изменения длительности 
сэмпла без изменения высоты тона с учетом свойств сэмпла.  

Возможностями Time stretching следует пользоваться в том случае, если в этом 
действительно есть необходимость. Например, если у вас есть вокальные партии, 
записанные в одном темпе, а требуется сделать ремикс в другом темпе. Следует 
учитывать также то, что все алгоритмы, кроме Resample, не работают в масштабе 
реального ремени. Это значит, что вы не можете использовать их в проектах, в 
которых темп не является постоянным. 

Чтобы полностью отключить работу алгоритма Time stretching, воспользуйтесь 
командой Reset контекстных меню регуляторов PITCH и MUL, а также командой 
(none) контекстного меню регулятора TIME. 

 

 



7.2. Плеер барабанных лупов Fruity Slicer

Перечислим новые опции плагина (рис. 21). Если включена опция AUTO-FIT, то 
сразу после загрузки лупа основные параметры синтеза Fruity Slicer будут 
автоматически "подогнаны" под текущий темп проекта. 

Переключателем DECLICK включается режим подавления щелчков на границах 
фрагментов лупа. 

 

Рис. 21. Панель плагина Fruity Slicer 

Регулятором PS задается смещение высоты тона для всего лупа. 

Если оригинальный темп лупа больше темпа проекта, то возникает не очень 
хорошая ситуация: между отдельными фрагментами лупа, обладающими своей 
акустической атмосферой, образуются паузы. Заполнить эти фрагменты тишины 
звучанием фрагментов лупа можно с помощью функции FILL GAPS. 
Соответствующим регулятором задается степень растяжения или сжатия 
фрагментов лупа. Программа может автоматически подобрать значение этого 
параметра так, чтобы заполнить паузы. Для этого следует щелкнуть на регуляторе 
FILL GAPS правой кнопкой мыши и в открывшемся контекстном меню выбрать 
команду Autodetect. С помощью опций A, B, C, D выбираются разные алгоритмы 
растяжения/сжатия фрагментов лупа. Выбирайте тот алгоритм, который позволит 
получить наиболее качественное звучание в каждом конкретном случае. 

Если включена опция PLAY TO END, то каждый фрагмент сэмпла будет 
воспроизводиться от своей левой границы до самого конца сэмпла. 



Кнопка открывает меню, содержащее несколько групп команд. Разбиение лупа 
на фрагменты, выполняемое после его загрузки в плагин, не является 
окончательным и бесповоротным. Расположение границ фрагментов может 
изменяться вследствие изменения параметров плагина с помощью этих команд. 
Перечислим их: 

• Use sample built-in slicing - использовать информацию о разбиении лупа на 
фрагменты из звукового файла;  

• Dull auto-slicing - слабая чувствительность алгоритма детектирования 
отдельных звуков;  

• Medium auto-slicing - средняя чувствительность алгоритма детектирования 
отдельных звуков;  

• Sharp auto-slicing - высокая чувствительность алгоритма детектирования 
отдельных звуков;  

• 1/6 beat, 1/4 beat, 1/3 beat, 1/2 beat, Beat - режим разбиения лупа на равные 
фрагменты соответствующей длительности;  

• No slicing - весь луп будет восприниматься программой как один фрагмент;  
• Zero cross check slices - корректировка границ фрагмента таким образом, 

чтобы они соответствовали точкам пересечения волновой формой оси 
нулевого уровня (чтобы избежать щелчков на границах фрагментов);  

• Open BeatSlicer - открыть специализированный редактор лупов BeatSlicer, 
демонстрационная версия которого входит в комплект поставки FL Studio.  

7.3. Драм-машина FPC (полное описание)

По своей сути FPC является сэмплером. Однако интерфейс FPC и функциональные 
особенности ориентированы на работу именно с ударными звуками. В FPC может 
быть загружено до 16 ритмических инструментов, в каждом из которых может быть 
задействовано множество слоев сэмплов. В поставку FPC входит два пресета с 
разными наборами ударных звуков. Вы можете создавать свои пресеты на основе 
любых звуковых файлов, поддерживаемых FL Studio. 

На панели FPC присутствуют три вкладки: 

• PADS - параметры пэдов;  
• LAYER PROPERTIES - параметры слоев;  
• MIXER - встроенный микшер.  

Начнем с того, что рассмотрим вкладку PADS панели FPC (рис. 22). 

7.3.1. Вкладка PADS панели FPC - параметры пэдов

Основную часть вкладки PADS панели FPC занимают две области, называемые 
"матрицами". Каждая ячейка этих матриц соответствует определенному ударному 
звуку, который будет воспроизводиться при нажатии определенной MIDI-клавиши. 
Кроме того, каждая ячейка одной матрицы взаимооднозначно соответствует 
определенной ячейке другой матрицы. Например, верхняя левая ячейка одной 
матрицы соответствует левой верхней ячейки другой. Вторая слева ячейка верхнего 
ряда одной матрицы соответствует второй слева ячейки верхнего ряда другой 
матрицы и т. д. В принципе, все элементы этих двух матриц можно было бы 
объединить в одну матрицу. Но разработчики решили представить параметры 
ударных звуков в виде двух матриц. 



Левая матрица содержит набор больших кнопок - пэдов. Вообще-то пэдом 
называется поверхность барабанного MIDI-контроллера, по которой барабанщик 
ударяет палочкой. Роль палочки в данном случае выполняет указатель мыши: вы 
можете щелкать по пэдам и вызывать звуки. Если щелкнуть по пэду, зазвучит 
соответствующий ударный инструмент. Кроме того, данный пэд получит статус 
текущего. Ряд параметров, доступных в виде регуляторов, которые расположены в 
верхней части панели, относятся только к текущему пэду. Если вы хотите выбрать 
пэд в качестве текущего, но не хотите, чтобы при этом издавались какие-либо звуки, 
то воспользуйтесь кнопкой (Pad properties), расположенной под основной кнопкой 
пэда. 

Примечание. Слева от кнопки (Pad properties) расположены безымянные кнопки 
. Теоретически с их помощью можно перебирать разные вариации ударного 

инструмента, соответствующего пэду. Однако на момент написания статьи в 
поставку FL Studio не входят такие банки ударных инструментов для FPC, в которых 
данная возможность была бы реализована. 

В левой верхней части панели располагается поле с номером текущего пэда. На рис. 
20 это поле содержит запись "Pad 1/16", что означает "1 пэд из 16". С помощью 
кнопок / , расположенных по краям данного поля, можно осуществлять смену 
текущего пэда. Название текущего пэда отображается правее указанного поля. 
Чтобы сменить название текущего пэда, следует щелкнуть по нему правой кнопкой 
мыши. Откроется маленькое окно Enter pad name, куда следует ввести новое 
название пэда или отредактировать старое. 

Справа от поля с названием текущего пэда расположены два вращающихся 
регулятора, называемых Pad volume (громкость пэда) и Pad pan (нанорама пэда). 

Еще правее расположены три кнопки-переключателя:  

• Mute - заглушить текущий пэд;  
• Solo - сделать текущий пэд солирующим;  
• Scale volume with velocity - изменять громкость звучания пэда в соответствии 

со значением параметра Velocity (скорости нажатия MIDI-клавиши).  

Рассмотрим вторую матрицу, расположенную в правой части панели. Каждая ее 
ячейка, соответствующая одному из пэдов, содержит следующие поля: 

• Pad note и Pad note octave - нота и октава, которой соответствует пэд;  
• Cut which group? и Cut by which group? - аналог параметров Cut и Cut by, 

доступных на вкладке MISC окна Channel settings (см. разд. 6.1.1 книги).  

http://www.petelin.ru/books/flstudio/flstudio.htm


 

Рис. 22. Панель плагина FPC (вкладка PADS) 

7.3.2. Вкладка LAYER PROPERTIES панели FPC - параметры слоев

Вид вкладки LAYER PROPERTIES панели FPC показан на рис. 23. Многие элементы 
этой вкладки вам уже знакомы. С их помощью вы можете выбирать и 
переименовывать текущий пэд, регулировать его громкость и панораму. Каждый пэд 
может состоять из множества слоев - сэмплов, которые будут воспроизводиться при 
условии, что значение параметра Velocity (скорость нажатия MIDI-клавиши) попадет 
в определенный диапазон значений. 

Примечание. Параметр Velocity, передаваемый специализированными 
барабанными MIDI-контроллерами, несет информацию о силе удара палочкой по 
барабанному пэду. 

Например, ударили вы по MIDI-клавише (или барабанному пэду) слегка - будет 
воспроизводиться один сэмпл ударного звука. Ударили сильнее - будет 
воспроизводиться уже другой сэмпл. 

С помощью кнопок CREATE и DELETE можно соответственно создавать и удалять 
слои. Каждый слой имеет свой порядковый номер. Количество слоев ограничено 
лишь здравым смыслом. Каждому слою соответствует ряд элементов управления. 
На рис. 23 представлено четыре слоя (ряды элементов с 1 по 4). В правой части 
панели присутствует вертикальный регулятор, выполняющий функцию полосы для 
прокрутки слоев. Осуществлять выбор текущего слоя можно с помощью пары кнопок 

, расположенных справа от кнопки DELETE. 

Правее от поля с номером слоя расположена кнопка, с помощью который данный 
слой можно выбрать в качестве текущего. 

Справа от этой кнопки подряд расположены три вращающихся регулятора: 
громкость, панорама и высота тона для соответствующего слоя. Справа от них 



расположено изображение волновой формы сэмпла, соответствующего слою. Если 
нужно послушать звучание слоя - щелкните на этом изображении. Еще правее 
расположена пара ползунковых регуляторов, с помощью которой задается область 
значений Velocity для слоя. 

По умолчанию включен режим Lock Layers. За его включение/выключение отвечает 
безымянная кнопка, расположенная правее кнопки SPREAD EVEN. В этом режиме 
области значений Velocity разных слоев в принципе не могут нахлестываться друг на 
друга. Но, если режим Lock Layers отключить, то можно, например, сделать так, 
чтобы при любом значении Velocity одновременно звучали все слои. 

Нажатие на кнопку SPREAD EVEN приведет к тому, что все слои пэда будут 
последовательно и равномерно занимать весь допустимый диапазон значений 
Velocity. 

В нижней части панели располагается поле с более крупным изображением 
волновой формы текущего пэда. С помощью кнопки (Load Sample) открывается 
стандартное диалоговое окно для загрузки сэмпла, который будет сопоставлен с 
текущим пэдом. Кнопкой REVERSE включается режим реверсивного (в обратном 
порядке) воспроизведения сэмпла. 

 

Рис. 23. Панель плагина FPC (вкладка LAYER PROPERTIES) 

7.3.3. Вкладка MIXER панели FPC - встроенный микшер

Вид вкладки MIXER панели FPC показан на рис. 24. Большую часть панели на 
данной вкладке занимают элементы встроенного микшера FPC. Каждому пэду FPC 
соответствует отдельная линейка микшера. Сигналы с разных линеек можно 
выводить на разные модули FX микшера FL Studio для независимой обработки 
разными наборами эффектов. Поскольку максимальное количество пэдов 16, то и 
линеек встроенного микшера FPC тоже 16. 



Напомним, что свойства любого канала доступны в окне Channel settings. В 
зависимости от типа плагина, подключенного к каналу, его панель может 
располагаться или на вкладке PLUGIN окна Channel settings, или в отдельном окне. 
Панель плагина FPC размещается в отдельном окне. Тем не менее, номер модуля 
FX микшера FL Studio, с которым ассоциирован данный канал, доступен в поле FX 
под заголовком окна Channel settings. Применительно к плагину FPC в этом поле 
задается номер базового модуля FX микшера. Сигналы с линеек микшера FPC могут 
выводиться на 16 разных модулей FX микшера FL Studio, начиная с базового модуля 
FX. В верхней части каждой линейки встроенного микшера FPC имеется числовое 
поле, в котором задается смещение относительно базового модуля FX. Например, 
если в этом поле задано число 3, а для FPC в качестве базового задан модуль FX 4, 
то сигнал пэда будет выводиться на модуль FX 7 (3 + 4 = 7). 

Перечислим остальные элементы линеек встроенного микшера FPC сверху вниз: 

• регулятор панорамы пэда (Pad pan);  
• регулятор громкости пэда (Pad volume);  
• кнопки Mute и Solo;  
• поле с названием пэда.  

 

Рис. 24. Панель плагина FPC (вкладка MIXER) 

7.3.4. Работа с шаблонами партий ударных инструментов

В поставку FPC Studio входит большое количество шаблонов (MIDI-файлов) с 
партиями ударных инструментов. По умолчанию они располагаются в папке 
C:\PROGRAM FILES\IMAGE-LINE\FLSTUDIO5\DATA\PATCHES\SCORES\FPC 
DRUMLOOPS. В правой верхней части FPC имеется поле, где отображается 
название текущего MIDI-файла, выбранного в качестве шаблона (рис. 6.25). С 
помощью кнопок и можно перебирать файлы шаблонов, хранящихся в одном 
каталоге. А с помощью кнопки в качестве шаблона можно выбрать MIDI-файл из 



любой доступной папки. После этого перебор MIDI-файлов кнопками и будет 
осуществляться только в пределах этой папки. 

Данные из MIDI-файла, выбранного в качестве шаблона, автоматически копируются 
в текущий паттерн в виде трека отпечатков клавиш, связанного с каналом FPC (рис. 
6.25). Название канала соответствует банку ударных звуков, загруженных в FPC. В 
нашем примере банк называется Tama. Само собой разумеется, вы можете 
редактировать трек отпечатков клавиш по своему усмотрению. Однако как только 
средствами FPC вы выберете какой-либо другой файл шаблона, его данные заменят 
содержание текущего трека отпечатков клавиш, а изменения, внесенные вами, не 
сохранятся. 

 

Рис. 25. Выбор MIDI-файла с шаблоном партии ударных инструментов 

7.3.5. Создание собственных пресетов с наборами ударных звуков

Данный раздел не содержит никакой принципиально новой информации. Мы хотим 
помочь закрепить знания, полученные вами ранее. 



Итак, у вас имеется набор звуковых файлов, содержащих нужные вам ударные 
звуки. Требуется на их базе создать новый банк для FPC. Загрузите в FPC пресет, 
соответствующий пустому банку, не содержащему ни каких звуков. Для этого с 
помощью кнопки , расположенной в левом верхнем углу панели FPC, откройте 
стандартное меню плагина (см. разд. 6.5 книги) и выберите команду Presets > 
Empty. 

Перейдите на вкладку LAYER PROPERTIES. Выберите нужный пэд и загрузите в 
него один или несколько звуковых файлов. В случае необходимости, распределите 
их по разным областям значений Velocity. Проделайте это для остальных пэдов. 

Перейдите на вкладку PADS. Установите соответствие пэдов нужным нотам и 
октавам. 

Командой Save Preset As стандартного меню плагина сохраните пресет в файле с 
заданным именем. Впоследствии этот пресет можно загружать с помощью команды 
Presets > название пресета стандартного меню плагина или средствами окна 
браузера Browser. 

7.4. Гранулярный синтезатор Fruity Granulizer

 

Рис. 26. Панель плагина Fruity Granulizer 

В новой группе TRANSIENTS доступны параметры обработки фрагментов сэмплов, 
содержащих скачкообразные изменения уровня сигнала. Для более качественной 
обработки барабанных лупов, или другого звукового материала, содержащего 
отдельные участки с резкими изменениями уровня сигнала, в Fruity Granulizer 

http://www.petelin.ru/books/flstudio/flstudio.htm


предусмотрена специальная обработка этих участков. Звуковой файл, загруженный 
в Fruity Granulizer, может содержать информацию о границах ударных звуков. Если 
выбрана опция USE REGIONS, то Fruity Granulizer будет использовать эту 
информацию. Если выбрана опция DETECT, то Fruity Granulizer будет 
самостоятельно детектировать резкие звуки. 

Напомним: "обычный" размер гранул задается параметром HOLD группы GRAINS. 
Допустим, при обработке сэмпла Fruity Granulizer детектирует скачкообразное 
изменение уровня сигнала. Фронт этого изменения, скорее всего, попадает в 
пределы обычной гранулы. Тогда Fruity Granulizer корректирует длительность этой 
гранулы так, чтобы резкий звук не попадал в ее пределы. Последующие гранулы, 
используемые для обработки резкого звука, будут иметь длительность, задаваемую 
регулятором HOLD группы TRANSIENTS. 

Чтобы отключить индивидуальную обработку резких звуков, следует выбрать опцию 
OFF. 

В группе TIME доступны следующие параметры: 

• START - позиция, начиная с которой будут воспроизводиться гранулы сэмпла;  
• LOOP - режим циклического воспроизведения гранул сэмпла;  
• HOLD - воспроизводить только текущую гранулу.  

Нажатие кнопки HOLD дает такой же результат, как и поворот регулятора W.SP 
против часовой стрелки в крайнее положение (0%). Однако кнопку можно нажать 
одним щелчком, а пока вы поворачиваете регулятор, может начать 
воспроизводиться другая гранула. 

По умолчанию от того, какая MIDI-клавиша нажата, зависит высота тона сигнала, 
воспроизводимого Fruity Granulizer. С помощью кнопки KEY TO открывается меню, с 
помощью которого можно выбрать другие зависимости. Т. е. от номера нажатой 
MIDI-клавиши может зависеть не только высота звука, но и другие параметры: 

• Pitch - высота звука (выбрано по умолчанию);  
• Percent - параметр START, задаваемый в % (клавиша до 5-й октавы 

соответствует START = 0%, до 7-й октавы соответствует START = 100%);  
• Step - параметр START, задаваемый в шагах секвенсора FL Studio (клавиша 

до 5-й октавы соответствует START = 0 шагов, до 6-й октавы соответствует 
START = 12 шагов, до 7-й октавы - 24 шага и т. д.);  

• Transient - параметр START, задаваемый порядковым номером ударного 
звука в сэмпле (первому ударному звуку соответствует до 5-й октавы).  

7.5. Fruity Video Player - проигрыватель видеофайлов

FL Studio можно использовать для создания звукового трека к фильму. Но чтобы 
работать над звуковым треком, хорошо бы иметь перед глазами соответствующий 
видеоряд. Специализированный плагин Fruity Video Player, подключаемый в 
качестве генератора, позволяет воспроизводить любой видеофайл синхронно с 
проектом. А чтобы оригинальная звуковая дорожка не вклинивалась в звучание 
проекта FL Studio, с помощью кнопки MUTE ее можно заглушить. 

 



7.6. Плагин WaveShaper (полное описание)

Плагин Fruity WaveShaper позволяет реализовывать высококачественные эффекты 
овердрайв и дисторшн (рис. 27, а). Большую часть панели плагина занимает график 
передаточной характеристики (зависимость выходного сигнала от входного), 
который вы можете изменять по своему усмотрению. Горизонтальная ось графика 
соответствует уровню входного сигнала, вертикальная - уровню выходного. По 
умолчанию имеется всего два узла графика, которые расположены в левом нижнем 
и правом верхнем углах. Узлы - маленькие квадратики. Вы можете перемещать их с 
помощью мыши (удерживая нажатой ее левую кнопку). Чтобы добавить новый узел, 
следует щелкнуть на нужном месте графика правой кнопкой мыши. Между узлами 
присутствуют маленькие окружности, которые можно перемещать в вертикальном 
направлении. При этом будет изменяться кривизна (tension) графика на отрезке 
между двумя ближайшими узлами (рис. 27, б). 

  а      б    

Рис. 27. Панель плагина Fruity WaveShaper 

С помощью переключателя /  (Unipolar / bipolar mode) переключаются 
униполярный и биполярный режимы работы плагина. В униполярном режиме левая 
нижняя точка на координатной плоскости соответствует минимальным уровням 
входного и выходного сигналов, а верхняя правая - максимальным (0 дБ). В 
биполярном режиме работы учитывается полярность каждого отсчета цифрового 
звукового сигнала. Минимальным уровням входного и выходного сигналов 
соответствует центральная точка на координатной плоскости. 

Регулятором PRE задается усиление сигнала на входе плагина. MIX - уровень 
необработанного сигнала в общем миксе на выходе плагина. POST - усиление 
сигнала на выходе плагина. 

В левой нижней части окна плагина имеется кнопка (Options). С ее помощью 
открывается меню, содержащее следующие команды: 

• Open state file… - загрузить настройки плагина из файла;  



• Save state file… - сохранить настройки плагина в файле;  
• Copy state - копировать настройки плагина в буфер обмена;  
• Paste state - вставить настройки плагина из буфера обмена.  

Переключателем FREEZE включается такой режим, в котором вы не сможете 
изменить форму графика. Переключателем STEP включается такой режим 
редактирования графика, в котором можно рисовать последовательность узлов, 
если удерживать нажатой левую кнопку мыши. Если при этом удерживать еще и 
клавишу <Shift>, то график получится ступенчатым. Переключателем SNAP 
включается режим привязки узлов графика к сетке координатной плоскости. 

В поле OVERSAMPLE задается коэффициент оверсэмплинга. Оверсэмплингом 
(Oversampling) называется процесс увеличения частоты дискретизации цифрового 
сигнала с целью повышения точности его дальнейшей обработки. Например, если в 
вашем проекте используется частота дискретизации 48 кГц, а в поле OVERSAMPLE 
вы установили значение 16x, то часта дискретизации сигнала, обрабатываемого 
плагином будет равна 48 кГц x 16 = 768 кГц. Основное назначение оверсэмплинга - 
борьба с нежелательным эффектом, называемым элайсингом. Элайсинг (Aliasing) - 
проникновение ультразвукового шума при дискретизации аналогового сигнала или 
при обработке цифрового сигнала в слышимую область частот. После обработки 
сигнала плагином Fruity WaveShaper происходит понижение частоты дискретизации 
до ее первоначального значения. 

Переключателем CENTER включается режим подавления постоянной 
составляющей в сигнале на выходе плагина. Мы рекомендуем держать этот 
переключатель все время включенным. 

 
 
 

8. Новые команды главного меню
OPTIONS > Loop record - включение/выключение режима циклической записи, 
дублирует аналогичную опцию панели Recording. 

OPTIONS > Auto scrolling - включение/выключение режима автоматического 
скроллинга в окнах пошагового секвенсора, Piano roll, Playlist, команда дублирует 
аналогичную опцию панели Recording. 

Команда TOOLS > External tools открывает диалоговое окно External tools (рис. 28). 
С его помощью вы можете самостоятельно добавлять новые команды в меню 
TOOLS для вызова указанных вами приложений. 



 

Рис. 28. Диалоговое окно External tools (добавлено приложение Audition) 

Появилась опция Default editor - заданное приложение будет вызываться вместо 
встроенного редактора WaveEditor. 

Может возникнуть вопрос, как удалить запись из списка приложений окна External 
tools? Для этого нужно эту запись выбрать и вручную очистить содержимое полей 
Name и File location. 

Меню HELP, традиционно содержит команды вызова руководства пользователя FL 
Studio, информацию о программе, полезные ссылки на ресурсы Internet. Однако в 
меню HELP имеются также и команды, имеющие непосредственное отношение к 
функционированию FL Studio: 

• Stop sound (panic), <Ctrl> + <H> - немедленно прекратить воспроизведение 
любой MIDI- и аудиоинформации;  

• Cancel current recording - отмена текущей записи.  

Команду Cancel current recording при необходимости следует применять 
непосредственно во время сессии записи. После ее применения удаляется любая 
записанная информация. 

 
 

 


